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bPurpose 
and 
Features

Data I/O created and hosts an application on the World Wide Web for 
developing device support. electronic Device Support Suite, 
or eDSS, creates and manages files that support programming spe-
cific semiconductor devices on Data I/O products with FlashCORE 
programmers including FlashPAK, RoadRunner, PS288FC and 
PS300FC systems. This Getting Started Guide provides information 
about setting up eDSS hardware and software. 

The eDSS application:
• Searches for existing device supports
• Allows creating a new device support by cloning an existing 

device support
• Aids in creating Sector Tables and choosing Adapter Kits
• Allows selecting Special Features such as Bad block schemes 

for NAND devices
• Produces Algorithm Load Modules by using your Algorithm and 

DevParms files
• Makes Linked-In Algorithms for debugging
• Manages multiple users and security levels
• Allows control of system versions, one-time-programmable 

(OTP) sectors, and sector protection
• Saves the resulting files in a specified directory

Computer 
System

Your computer system must meet these requirements: 
• IBM compatible PC (minimum processor: Pentium III or compa-

rable) 
• Microsoft Windows operating system 98SE or higher 

(Windows XP recommended)
• 256 MB or more RAM recommended
• 1.2 GB free hard disk space 
• Internet connection (Broadband Synchronous 128 Kbit/sec or 

faster recommended)
• CD-ROM drive
• PC-based PCMCIA card reader/writer (external USB or Internal 

ISA/PCI)
• Parallel port 
• Internet Explorer 6.0 or higher
• Macromedia Flash Player Version 7.0 or higher
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STEP 1:
Check 
Contents 
of eDSS 
Boxes

Open the eDSS boxes and verify that you received the following:
• Getting Started Guide (Data I/O PN 983-0724-003)
• Certification of Conformance (Data I/O PN 090-0732-002)
• FlashPAK Developer Station (Data I/O PN 901-0121-004 or later, 

with Power Cord and connections for the Developer Board and 
the optional debugger interface)

• Parallel Port Cable (Data I/O PN 411-0197-001)
• PCMCIA ATA Flash Card (Data I/O PN 489-0001-003)
• FP-PAK-T009 48TSOP Adapter (Data I/O PN 941-0287-004)
• FlashPAK Operator’s Guide (Data I/O PN 096-0239-003)
• FlashPAK CD (Data I/O PN 326-0628-001)
• Developer Board (Data I/O PN 701-3691)
• Universal Developer Adapter (Data I/O PN 701-3707-002)
• Jumper Cables (Data I/O PN 709-0586-002)
• Vacuum tool
• Allen wrench (4 mm)

STEP 2:
Set Up 
FlashPAK 
Developer 
Station

1. Unpack the FlashPAK Developer Station. 

NOTE: Use ESD precautions. Plug an ESD strap into the 
back of the FlashPAK Developer Station before handling 
Socket Adapter or devices.

2. Lift off the Actuator Cover.

Figure 1—Lift off Actuator Cover

3. Unbox the Socket Adapter.
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4. Lift the bracket open and install the Socket Adapter onto the 
dowel pins.

Figure 2—Install Socket Adapter

5. Lower the bracket and screw in two screws. An Allen wrench 
(hex key) is included.

Figure 3—Attach bracket

6. Re-install the Actuator Cover.
7. Plug in the Power Cord.
8. Plug the FlashPAK Developer Station ribbon cable into the 

Developer Board.

Figure 4—FlashPAK Developer Station connection to
Developer Board

NOTE: For instructions on how to set up the Universal Devel-
oper Adapter, see “developer adapter” in Device Support 
Training. (See page 20 for help in opening and using Device 
Support Training.)
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STEP 3:
Set Up 
eDSS

1. Launch Internet Explorer. 
2. Open a version of eDSS: 
• For training purposes, go to https://dsds.dataio.com/ (you need 

only a User Name and Password).
• For authentic device support creation, go to 

https://edss.dataio.com/ (you need a Data I/O account as well as 
a User Name and Password).

3. Click Yes to the Security Alert.

Figure 5—Security Alert

4. Add eDSS to your Internet Explorer favorites.

NOTE: See your eDSS Administrator for your User Name 
and Password. You will need these to log on.

5. At the Logon window, enter your User Name and Password, and 
select your Role. Click Sign In.

Figure 6—Logon Window

https://dsds.dataio.com
https://edss.dataio.com� 
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6. Click the Tutorial icon on the eDSS icon bar.

Figure 7—Click Tutorial icon

7. On the next window, click Browser Setting:

Figure 8—Click Browser Setting

NOTE: If your PC does not have Macromedia Flash player 
installed, you will be asked if you wish to install it. Follow the 
prompts to install.

8. Follow the instructions in Browser Setting to configure your 
Internet Explorer browser for the most efficient use of eDSS 
tools. 

9. Optional: You can install a root certificate stating that Data I/O is 
a trusted source. This certificate eliminates warnings when you 
sign in. You need to install this only once.

To install the root certificate:

9a) Click the Root Certificate icon in the eDSS icon bar.

Figure 9—Click Root Certificate icon

9b) Select Open.
9c) Follow the prompts to install.
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STEP 4:
Connect 
Debugger 
Interface

If you do source level debugging of algorithm code, purchase either a 
Node Locked License or Floating License copy of “SingleStep Black-
bird Debugger for PPC 8xx” from Wind River, which includes the Sin-
gleStep debugger software and the interface hardware. 

Wind River part numbers are: 
• Part # WIN-BBMPP8-NL (Node Locked License)
• Part # WIN-BBMPP8-FL (Floating License)

Contact Wind River at http://www.windriver.com/

To use the debugger, complete “STEP 4: Connect Debugger Inter-
face,”  “STEP 5: Install Debugger Software,“ and “STEP 6: Configure 
Debugger Software.”

To connect the debugger interface:

1. Plug the debugger interface cable into the FlashPAK Developer 
Station cable. 

NOTE: Align the red stripes on the two cables.

Figure 10—FlashPAK Developer Station connection to
 debugger interface cable

2. Using the Parallel Port Cable, connect the debugger interface to 
your PC. 

3. Plug the Power Supply Unit into the debugger interface and plug 
in to a power outlet.

NOTE: If you wish to use the FlashPAK Developer Station 
without the debugger, remove power to the debugger. The 
Parallel Port Cable between the debugger and your PC may 
remain connected even when the debugger is not in use.

http://www.windriver.com/
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STEP 5:
Install 
Debugger 
Software

1. Close all other programs.
2. Insert the SingleStep 7.6.2 CD into your PC's CD-ROM drive. 

NOTE: You may see an error message telling you that it can-
not find projectr.exe. Close the error message box. This 
error occurs because the CD assumes that the Unix environ-
ment is the default setting. 

3. Using Windows Explorer, go to your CD drive and browse to the 
PC\Release directory. Run setup.exe in this directory. The 
splash screen appears. Click Next> on the Welcome window.

Figure 11—Click Next
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4. Click Yes on the Software License Agreement window if you 
accept.

Figure 12—Click Yes to accept license agreement

5. Select Typical on the Choose Product Install Type window. 
Click Next>.

Figure 13—Select Typical
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6. Select Stand Alone on the Select Licensing Type window. Click 
Next>.

Figure 14—Select Stand Alone

7. Select Single Step On Chip (MPC8xx) (has device driver) on the 
Select Products to Install window. Click Next>.

Figure 15—Select SingleStep On Chip (MPC8xx) (has device)
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8. The default path for the Destination Directory is c:\sds762 on 
the Choose Destination Location window. Use the Browse but-
ton to change the location if this is not what you want. Click 
Next> when you are satisfied with the Destination Directory.

Figure 16—Choose destination location

9. Click Next> on the Select Program Folder window.

Figure 17—Select program folder
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10. Select I have no license file on the Select License File Location 
window. Click Next>.

Figure 18—Select I have no license file

11. Click OK to the Warning.

Figure 19—Click OK to Warning
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12. Click Next> on the Start Copying Files window.

Figure 20—Start copying files

13. Click Next> on the Licensing Information window.

Figure 21—Click Next
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14. Select Yes, I want to restart my computer now on the Setup 
Complete window. Click Finish.

Figure 22—Click Finish

15. When your PC is restarting, examine the setting of your parallel 
port by pressing F2 to go to the Setup window. SingleStep 
debugger software only works if your parallel port is set to 
(Bi-Directional) EPP mode. On some PCs (Dell Optiplex) it may 
say PS/2 mode. If it is not already in this mode, you need to 
change it and save the setting. 

NOTE: Do not run the debugger software until you have com-
pleted Step 16.

16. Set up your SingleStep debugger software license according to 
the instructions provided by Wind River.

Installation of the debugger software is now complete. Before using 
the debugger software for the first time, complete the configuration 
procedure in “STEP 6: Configure Debugger Software.”
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STEP 6:
Configure 
Debugger 
Software

1. Launch eDSS and sign in. 
2. Click the icon to download the debugger configuration files.

STEP 6: Configure Debugger Software 

Figure 23—Click download icon

3. Unzip the files to the x:\sds762\cmd\ directory, where x is your 
local drive. 

4. Follow the instructions in the Readme.txt file.
5. Turn on the FlashPAK Developer Station.
6. Start the debugger by using Windows Explorer to browse to and 

select SingleStep on Chip (MPC8xx). 

Figure 24—Start the debugger
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7. When the debugger starts, the File tab is active. Click Cancel to 
close the dialog and return to the Main menu.

Figure 25—Click Cancel

8. From the Tools menu, check the option to Save on Exit. Then 
press Ctrl + D or click the Debug icon on the Main window. 

Figure 26—Check Save on Exit
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9. Set the File tab as shown.

Figure 27—File Tab Settings

10. Set the Connection tab as shown: 

Figure 28—Connection Tab Settings
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11. Set the Processor tab as shown: 

Figure 29—Processor Tab Settings

12. Set the Registers tab as shown:

Figure 30—Registers Tab Settings
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13. Set the Options tab as shown:

Figure 31—Options Tab Settings

14. Set the Target Configuration tab as shown:

Figure 32—Target Configuration Tab Settings

15. Click OK. Your debugger settings are saved. 

NOTE: When you are ready to begin debugging, return to the 
File tab (see Figure 27 on page 16), de-select Debug without 
a file, and browse to the sysflash.elf file you wish to debug.
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Important 
Resources

Four important resources are available to assist you in using eDSS:
• eDSS Help 
• Tutorials
• Device Support Training
• Data I/O Customer Support

eDSS Help
eDSS Help contains information on using the features of the eDSS 
application. 

To open and save eDSS Help:

1. Click the Help icon in the eDSS icon bar. 

Figure 33— Click Help icon

2. Save the Help file to your PC’s hard drive. 
3. Create a shortcut on your desktop for eDSS Help.

Tutorials
Tutorials are short videos that provide information about how to con-
figure your Internet Explorer browser settings, use the eDSS applica-
tion, access the three levels of help, and create derivative device 
support.

To open and watch Tutorials:

1. Click the Tutorial icon on the eDSS icon bar.

Figure 34—Click Tutorial icon

2. On the new window, select the Tutorial you wish to view:

Figure 35—Select the Tutorial you wish to view
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NOTE: If your PC does not have Macromedia Flash player 
installed, you will be asked if you wish to install it. Follow the 
prompts to install.

Browser Setting helps you with configuring your Internet Explorer 
browser for the most efficient use of eDSS tools.

Three Level Help provides a brief look at page level help, the full 
Help file, and the Training Guide.

The Big Picture provides the overall concept (or “Big Picture”) of cre-
ating device support using eDSS tools.

Derivative Support shows the process of creating a derivative 
device support by cloning.

Device Support Training
Device Support Training contains information on how to develop 
device support, such as creating pinout diagrams, creating functional 
tests, debugging new device support files, setting up the Universal 
Developer Adapter, and related topics. 

To open and save Device Support Training:

1. Click DS Training on the Home page of eDSS Help.

Figure 36—Click DS Training to open



  • Important Resources

eDSS: Getting Started Guide 21

2. Save the file to your PC’s hard drive. 
3. Create a shortcut on your desktop for Device Support Training.

Figure 37 shows the Welcome page and Table of Contents of Device 
Support Training:
 

Figure 37—Device Support Training with Table of Contents

Customer Support
For questions or assistance, contact Data I/O Customer Support:

Data I/O Corporation

Shipping address 10525 Willows Road N.E.
Redmond, WA USA 98052

Mailing address P.O. Box 97046
Redmond, WA USA 98073-9746

Telephone 425-867-6870

Toll free in USA  1-800-3 DATAIO (1-800-332-8246) 

Fax 425-867-6898

E-mail support@dataio.com
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Data I/O China (Shanghai)

Address Suite 2401, South Tower
528 South Pudong Road
Shanghai 200120 China PRC

Telephone +86-21-6881-6808

Fax +86-21-6881-6818

Data I/O Germany

Address Lochhamer Schlag 5
82166 Graefelfing, Germany

Telephone +49-89-85858-66

Fax +49-89-85858-10

Mail ccs-europe@data-io.de

Other Countries

For technical support in other countries, contact your local Data I/O 
representative. To find your local representative, go to 
www.dataio.com/contact/repsearch.asp 

www.dataio.com/contact/repsearch.asp
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